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PENDAHULUAN 

 

A. Pengantar Perkuliahan 

Pada perkuliahan ini, mahasiswa akan dibimbing mempersiapkan diri untuk 

mengikuti ujian sertifikasi Microsoft Office Specialist (MOS) kategori Microsoft Word 

2013. Perkuliahan dilaksanakan di laboratorium komputer selama 11 minggu pertemuan 

tatap muka, lalu pada minggu ke-12 hingga ke-14, mahasiswa secara bergiliran akan 

menempuh ujian sertifikasi MOS yang diselenggarakan di laboratorium Pusat Komputer 

Universitas Teknologi Yogyakarta (UTY). Ada lima pokok bahasan utama (objective) 

yang dibahas dan diujikan, yakni: Create and Manage Documents, Format Text and 

Paragraphs, Create Table and Lists, Apply References, dan Insert and Format Objects. 

Mahasiswa yang lulus ujian sertifikasi MOS (minimal mendapat nilai 700) secara otomatis 

mendapatkan nilai A untuk mata kuliah APTI 2 ini, sedangkan bagi yang tidak lulus maka 

akan mendapatkan nilai sesuai mekanisme yang pada Rencana Perkuliahan Semester 

(RPS). 

 

B. Kemampuan Akhir yang Diharapkan 

Pada perkuliahan ini mahasiswa diharapkan: 

1. Memahami pertanyaan-pertanyaan pada ujian sertifikasi MOS. 

2. Memahami Langkah-langkah untuk menjawab pertanyaan sertifikasi terkait topik yang 

ada pada kelima pokok bahasan. 

 

C. Kegiatan Pembelajaran 

Pada perkuliahan ini, mahasiswa dan dosen melakukan kegiatan pembelajaran sebagai 

berikut: 

1. Sebelum pelaksanaan perkuliahan, mahasiswa diminta membaca terlebih dahulu 

jobsheet praktikum yang telah diberikan. 

2. Materi kuliah disampaikan dengan langsung membahas contoh-contoh soal ujian 

sertifikasi MOS yang pernah diujikan ataupun soal-soal yang dibuat oleh dosen 

pengampu mata kuliah APTI 2. 

3. Di tengah dan akhir tiap pertemuan perkuliahan, mahasiswa diberi latihan mandiri 

untuk menjawab beberapa soal ujian. 



2 

 

D. Jadwal Perkuliahan 

Perkuliahan APTI 2 ini dilaksanakan sebanyak 14 kali pertemuan, namun perkuliahan 

tatap muka hanya dilaksanakan pada pertemuan ke-1 s.d. ke-11, setelah itu mahasiswa 

secara bergiliran mengikut ujian sertifikasi. Berikut ini adalah jadwal dan agenda 

perkuliahan APTI 2 selama satu semester: 

 

Pertemuan ke- Materi Perkuliahan 

1 Objective 1: Create and Manage Documents 

2 Objective 1: Create and Manage Documents  

3 Objective 2: Format Text and Paragraphs 

4 Simulasi Ujian ke-1 

5 Objective 3: Create Table and Lists 

6 Simulasi Ujian ke-2 

7 Responsi 

Ujian Tengah Semester (UTS) 

8 Objective 4: Apply References 

9 Simulasi Ujian ke-3 

10 Objective 5: Insert and Format Objects 

11 Simulasi Ujian ke-4 

12 Ujian sertifikasi MOS – kloter 1 

13 Ujian sertifikasi MOS – kloter 2 

14 Ujian sertifikasi MOS – kloter 3 

Ujian Akhir Semester (UAS) 
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OBJECTIVE 1 – BAGIAN 1 

“Create and Manage Documents” 

 

Tujuan Praktikum 

Praktikum ini bertujuan untuk memberikan pengetahuan dasar kepada praktikan mengenai 

aspek “Create and Manage Documents” pada Ms. Word 2013 yang meliputi fungsi-fungsi pada 

menu File, Home, Insert, Design, dan Layout. Dokumen-dokumen Latihan dapat diakses pada 

halaman E-Learning yang dibagikan oleh dosen pengampu perkuliahan.  

 

Task 1 – Open a non-native file using Ms. Word  

Open “Word_1-1b.txt” located inside “Objective 1” folder  

 Use Ms. Word 2013 installed on your computer to open it 

 Remember, do not use any short cut key! 

 

Task 2 – Create and save a new Word Document 

Create a new Blank Document  

 Save it using “Word 97-2003 Documents (.doc)” type 

 File Location : inside “Objective 1” folder 

 File Name : “Exercise 1” 

 

Task 3 – Copy and Paste text 

Copy and paste all the text inside “Word_1-1b.txt” 

 Paste the text to “Exercise 1.doc” document 

 Save the document 

 

Task 4 – Find and format certain word in a document 

Add highlight to the word “Toymakers” inside “Word_1-2.docx” 

 Apply to all related words  

 Highlight colour: Gray-25% 
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Task 5 – Insert hyperlink to the text 

Insert a hyperlink 

 To the text “sarah@wingtiptoys.com” in “Word_1-2.docx” 

 Link to  : Email address 

 E-mail address : “sarah@wingtiptoys.com” 

 Screen tip  : “Click to send an email directly” 

 Text to display : “sarah@wingtiptoys.com” 

 

Task 6 – Insert bookmark 

Insert bookmark 

 Apply to “Hand-Carved Toys” heading in the 2nd page of “Word_1-2.docx” 

 Bookmark name : “hand_carved” 

 

Task 7 – Manage Paper size and margins 

Set the paper size and margins  from “Word_1-3a.docx” document 

 Apply to the whole document 

 Paper size  : A4 

 Margins  : top 2 cm, bottom 2 cm, left 3 cm, and right 2,5 cm 

 

Task 8 – Format columns 

Format columns to the text in “Word_1-3a.docx” document 

 Apply to the first paragraph only 

 Columns   : Three columns 

 Space between columns : 1,5cm 

 

Task 9 – Apply Theme 

Apply theme to the document 

 Apply to the whole document 

 Theme  : Facet 
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 Theme Colors : Red Orange 

 Font Set  : Corbel 

 

Task 10 – Insert header 

Insert header to the document 

 Odd page and even page must use different header and ensure that the header does not 

appear on the first page 

 Even page : Facet (Even Page) header 

 Odd page : Facet (Odd Page) header 

 

Task 11 – Insert Watermark 

Insert Text Watermark to the document 

 Display the phrase “Example Only” to the page background 

 Font  : Arial 

 Size  : 36pt 

 Color  : Red, Accent 1, Lighter 60% (semitransparent) 

 Layout : Diagonal 

 

Task 12 – Modify style set 

Modify Style Set to the “Word_1-3b.docx” document 

 Apply to the whole document 

 Style set : Casual style set 

 

Task 13 – Insert and format page numbers 

Add and format page numbers to the document 

 Place the page number in the page margin area 

 Page number  : “Circle, Right” 

 Format Page Numbers : uppercase Roman numerals 
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OBJECTIVE 1 – BAGIAN 2 

“Create and Manage Documents” 

 

Tujuan Praktikum 

Praktikum ini merupakan kelanjutan dari materi Objecive 1 pada praktikum kesatu. Pada materi 

ini, praktikan akan diajarkan pengetahuan dasar mengenai Styles, Document Property, 

Customize Ribbon and Toolbar, dan memodifikasi Document View. Dokumen-dokumen 

Latihan dapat diakses pada halaman E-Learning yang dibagikan oleh dosen pengampu 

perkuliahan.  

 

Task 1 – Modify Styles  

Modify Title Styles in “Word_1-3a.docx” 

 Apply to this document only 

 Formatting : Bold, 18pt,   

 Format text  : All Caps 

 

Task 2 – Modify Styles  

Modify Heading 1 Styles in “Word_1-3a.docx” 

 Apply to this document only 

 Format text: 

- Spacing after : 10pt 

- Line Spacing : 1.5 lines 

 

Task 3 – Changing Document Views  

Change the page movement 

 Apply to “Word_1-3b.docx” 

 Page movement Side to side 
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Task 4 – Zoom the document view 

Zoom the document 

  Apply to “Word_1-3b.docx” 

 Zoom: 100% 

 

Task 5 – Customizing the quick access toolbar 

Add menus to the quick access toolbar 

  They only appear in this document 

 Choose command from: 

- Home tab  : Format Painter, Shading Button 

- Review tab : Comment Button 

Add separator between the commands from Home tab and Review tab  

 

Task 6 – Customize the ribbon 

Customize the ribbon 

  Apply to the Main tabs 

 Display the Developer tab 

 Uncheck the View tab 

 Rename the Page Layout tab into Layout 

 

Task 7 – Setting the document property 

Add a document property 

  “Word_1-4b.docx” 

 Title  : “All about Bamboo” 

 Subject : “bamboo” 
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Task 8 – Setting the document property 

Add a document property 

  “Word_1-4b.docx” 

 Author : “Abraham” 

 Keywords : “rhizomes”, “tropical”, and “mites” 

 

Task 9 – Save file into PDF 

Save file as PDF 

  Apply to “Word_1-4b.docx” 

 Type: PDF 

 

Task 10 – Protecting document using password 

Add password to protect the document 

  Apply to a new document using “Student Report” template 

 Password : “5tudentRep0rt” 

 

Task 11 – Mark the document as final 

Mark the document as final 

  Apply to previous file in Task 10 

 File location : inside “Objective 1” folder 

 File name : “Student Report 2019” 

 File type : Word document 
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OBJECTIVE 2 

“Format Text and Paragraphs” 

 

Tujuan Praktikum 

Praktikum ini bertujuan untuk memberikan pengetahuan dasar kepada praktikan mengenai 

aspek “Format Text and Paragraphs” pada Ms. Word 2013 yang meliputi fungsi-fungsi Insert 

symbols, Styles, Find and Replace, Insert WordArt, dan Alignment. Dokumen-dokumen 

Latihan dapat diakses pada halaman E-Learning yang dibagikan oleh dosen pengampu 

perkuliahan. 

 

Task 1 – Inserting symbols and special character  

Insert the copyright symbol (©) 

 First paragraph in “Word_2-1a.docx” 

 After the word “Microsoft” 

 

Task 2 – Replace text   

Replace all the text “(trademark)” 

 Apply to instances in which the word “trademark” is in parentheses  

 Replace with trademark symbol (™) 

 

Task 3 – Applying Styles 

Apply a Style to the text 

  “Word_2-2.docx” 

 Heading 1:  

• “Financial Summary” 

• “Financial Statements” 

• “Statement Notes” 
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Task 4 – Changing Styles 

Replace the Styles of all text formatted as Heading 3 

  From “Word_2-2.docx” 

 Replace with Heading 2 Style 

 

Task 5 – Insert WordArt Object 

Convert the text into Word Art object 

  Apply to “A Brief Review of Our Finances” sentence below the “Financial Report” title 

 Word Art style : Fill: Green, Accent Color 3; Sharp Bevel 

 Text Outline  : Orange, Accent 1, Lighter 40% 

 Text Reflection : Tight Reflection: Touching 

 Text Transform : Triangle: Down  

 

Task 6 – Setting the paragraph spacing 

Set the paragraph spacing 

  Apply to entire document (“Word_2-2.docx”) 

 Spacing : Relaxed 

 

Task 7 – Modify Style 

Modify Normal style 

  Apply to this document only 

 Indentation : First line, by 1 cm 

 

Task 8 – Set the Vertical Alignment 

Change the Vertical Alignment 

  Apply to all the text in the third page only 

 Vertical Alignment : Center 
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Task 9 – Inserting page break 

Insert a page break 

  In “Word_2-3.docx”, before the “Process” heading 

 Page breaks : Page 

 

Task 10 – Creating document section 

Create a section break 

  Apply to entire text started from “Carry out Project” heading 

 Section breaks  : Next Page  
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SIMULASI 1 

OBJECTIVE 1 – OBJECTIVE 2 

 

Petunjuk: 

1. Kerjakan 15 soal di bawah ini dalam waktu 40 menit 

2. Anggap simulasi ini adalah ujian sertifikasi sungguhan, sehingga Anda harus sungguh-

sungguh dalam mengerjakannya. 

3. Ingat, bacalah soal baris per baris mulai dari baris pertama. 

4. Usahakan untuk tidak membuka catatan. 

5. Dokumen simulasi dapat diunduh melalui halaman E-Learning UTY 

Soal: 

Task 1 – Page Border  

Create page border 

 Apply to all pages except the first page 

 Setting : Box 

 Color  : Blue-Gray, Text 2 

 Width : 2¼ pt  

 

Task 2 – Format Certain Words  

Find and Format Words 

 All words “Australia” 

 Font   : Bold 

 Font color  : Green, Accent 6, Darker 25% 

 Text Highlight color : Gray-25% 

 

Task 3 – Insert Hyperlink  

Insert a hyperlink 

 To word “www.creativecommons.org” in the top right of the third page 

 Link to : Existing File or Web Page 
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 Address : “www.creativecommons.org” 

 Screen tip : “Click to access the web page” 

 

Task 4 – Insert Page Numbers  

Insert page numbers 

 In the top right of the page except the the first page 

 Page Margins  : Accent Bar 2 

 Page Numbering : Start at 0 

 

Task 5 – Horizontal Alignment  

Align the text horizontally 

 “The Research Overview   …   disability” below the “Executive Summary” heading 

 Horizontal alignment : Justify 

 

Task 6 – Insert Columns  

Insert columns 

 “The material in this Research   …   course of action.” below the “Disclaimer” heading 

 Number of columns  : 2, Line between 

 Spacing between columns : 1 cm 

 

Task 7 – Document Theme  

Change document theme 

 Apply to the whole document 

 Theme  : Integral 

 Theme Colors  : Blue Warm 

 Style Set  : Shaded 
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Task 8 – Insert Watermark  

Insert text watermark 

 Display the phrase “Executive Summary” to the page background 

 Font  : Calibri 

 Size  : 44 pt 

 Color  : Teal, Accent 5, Darker 25% (semitransparent) 

 Layout : Diagonal 

 

Task 9 – Insert Symbol  

Insert symbol 

 To replace all the text “(copyright)” inside the document 

 Symbol : Copyright (©) 

 

Task 10 – Modifying Styles    

Modify Normal Styles 

 Apply to this document only 

 Formatting : Bold, 24pt 

 Format text  : All Caps 

 

Task 11 – Changing Styles  

Change the Styles  

  All text formatted as Heading 3 

 Replace with Heading 2 Style 
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Task 12 – Setting the Document Property  

Set the document property 

  This document only 

 Title  : “Research Overview” 

 Subject : “research” 

 Author : “Australia Cultural Ministers 2018” 

 Keywords : “arts”, “disability”, and “australia” 

 

Task 13 – Modify the paragraph spacing  

Modify the spacing after paragraph 

 Apply to “An initiative of the Meeting of Cultural Ministers 2018” below the title in the  

 first page 

 Spacing after : 20 pt  

 

Task 14 – Set the Vertical Alignment  

Align the page vertically 

  The last page only 

 Vertical Alignment : Justified 

 

Task 15 – Inserting page break  

Insert a page break 

  Before “The National Arts and Disability Strategy” heading 

 Page breaks : Page 
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OBJECTIVE 3 

“Create Tables and Lists” 

 

Tujuan Praktikum 

Praktikum ini bertujuan untuk memberikan pengetahuan dasar kepada praktikan mengenai 

pembuatan, pemformatan, dan pengeditan Table dan List pada Ms. Word 2013. Dokumen-

dokumen Latihan dapat diakses pada halaman E-Learning yang dibagikan oleh dosen 

pengampu perkuliahan.  

 

Task 1 – Creating table  

Create a simple table 

 Assign to a new blank document 

 Columns   : 3 

 Rows    : 10 

 Fixed Column Width : 2,5 cm 

 

Task 2 – Modifying table’s column   

Modify the column width 

 Apply to the table created in task 1 

 Autofit : Autofit Window 

 

Task 3 – Insert new rows and columns 

Add new rows and columns 

 Apply to the table created in task 1 

 Insert rows below  : 2 rows 

 Insert column to the left : 1 column 
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Task 4 – Convert text to table 

Convert text to a table 

 All tabbed text from “Distance … $20.00” below the “In-Home Trip Charge” heading      

      in “Word_3-1.docx” 

• Autofit to Contents 

• Separate text at Tabs 

 

Task 5 – Format the table 

Change the Table Styles  

  Assign to converted table from Task 4 

 Table Style  : Grid Table 7 Colourful – Accent 2 

 Table Shading : Orange, Accent 6, Lighter 40% 

 

Task 6 – Format the table 

Merge the table’s rows  

  The most top table in “Word_3-1.docx” 

• Merge all the rows in the 1st column 

• Align the word “Estimate” to Center Left 

 

Task 7 – Convert table to text 

Convert a table to text 

 The table below “Consultation Fee Schedule” heading 

 Separate text with Tabs 

 

Task 8 – Add borders to the table 

Add borders to the table 

 Table in “Word_3-2a” 

Border style : Double solid lines, ½ pt, Accent 3 

Borders  : All Border 
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Task 9 – Sorting the Table’s column  

Sort the table’s column 

  Table in “Word_3-2a” 

Sort by  : “City” (Ascending) 

Then by  : “First Name” (Descending) 

 

Task 10 – Creating bulleted list 

Create a bulleted list 

  To the content below “The Teacher” heading in “Word_3-3.docx” 

• Filled Circle Bullet 

• Indent bullet position : 0,7 cm 

• Line spacing  : 1,5 lines 

 

Task 11 – Creating a custom bulleted list 

Create a custom bulleted list 

  Assign to the content below “The Hero” heading 

• Bullet character :  

 

Task 12 – Creating numbered list 

Create a numbered list 

  Apply to the content below “The Sequence of Events” heading 

 Numbering list : Arabic number 

 Spacing before : 6 pt 
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SIMULASI 2 

OBJECTIVE 1 – OBJECTIVE 3 

 

Petunjuk: 

1. Kerjakan 18 soal di bawah ini dalam waktu 40 menit 

2. Anggap simulasi ini adalah ujian sertifikasi sungguhan, sehingga Anda harus sungguh-

sungguh dalam mengerjakannya. 

3. Ingat, bacalah soal baris per baris mulai dari baris pertama. 

4. Usahakan untuk tidak membuka catatan. 

5. Dokumen simulasi dapat diunduh melalui halaman E-Learning UTY 

 

Soal: 

Task 1 – Page Border  

Create page border 

 Apply to the first page only 

 Setting : Box 

 Color  : Black, Text 1, Lighter 25% 

 Width : 2¼ pt  

 

Task 2 – Replace certain words  

Replace words 

 All words “IPV4” and “IPV6” inside the document 

 Replace “IPV4” into “IPv4” 

 Replace “IPV6” into “IPv6” 
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Task 3 – Insert Hyperlink  

Insert hyperlinks 

 To the list below the “Index” heading in the 1st page 

 To the place in the document: 

• Introduction 

• Different scenarios of adoption of IoT 

• Standardization efforts 

• IPV6 adoption 

• Conclusion 

• References and consulted sources 

 

Task 4 – Insert Page Numbers  

Insert page numbers 

 In the bottom right of the page except the the first page 

 Page Number  : Accent Bar 4 

 Page Numbering : Start at 0 

 

Task 5 – Modifying the spacing after paragraph  

Modify the spacing after a paragraph 

 “Internet of Things …  development and growth” title 

 Spacing after : 24pt 

 

Task 6 – Insert Columns  

Insert columns 

 “The Internet of things … professional environment.” below the “Different scenarios of    

       IoT adoption” heading 

 Number of columns  : 2, Line between 

 Spacing between columns : 0,8 cm 

 

 

 



21 

 

Task 7 – Document Theme  

Change the document theme 

 Apply to the whole document 

 Theme  : Integral 

 

Task 8 – Insert Watermark  

Insert text watermark 

 Display the phrase “Internet of Things” to the page background 

 Font  : Calibri 

 Size  : 54 pt 

 Color  : Orange (semitransparent) 

 Layout : Diagonal 

 

Task 9 – Insert Symbol  

Insert symbol 

 Excatly after all the word “CISCO” in the 5th page 

 Symbol : trademark (™) 

 

Task 10 – Modifying Styles    

Modify Heading 2 Styles 

 Apply to this document only 

 Font size : 14pt 

 Format text  : All Caps 

 Spacing after : 12pt 
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Task 11 – Applying the Styles  

Apply the Styles  

 The four sub-heading below the “Standardization Efforts for IoT” heading 

 Style Emphasis: 

• ITU-T SG20 

• ZigBee 

• ETSI TC M2M 

• IETF 

 

Task 12 – Setting the Document Property  

Set the document property 

  This document only 

 Title  : “Internet of Things” 

 Subject : “internet” 

 Author : “Olga Cavalli” 

 Keywords : “internet”, “smart cities”, and “development” 

 

Task 13 – Inserting a Bulleted List  

Insert a bulleted list 

 Apply to the text “Drive competitiveness … Environment” below the “Standardization  

 Efforts for IoT” heading 

• Filled square Bullet 

• Indent bullet position : 0,7 cm 

• Spacing after  : 6 pt 

• Line spacing  : Exactly At 16pt 

 

Task 14 – Set the Vertical Alignment  

Align the page vertically 

  Apply to the whole document 

 Vertical Alignment : Justified 
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Task 15 – Inserting page break  

Insert a page break 

  Before “IPv6 adoption” heading 

 Page breaks : Page 

 

Task 16 – Repeat the header rows 

Repeat the table header  

  Table 1 in the beginning of the document 

 Repeat header rows 

 

Task 17 – Convert text to a table 

Convert the text to a table 

  “Parameters … 100 MHz” below the “Different scenarios of IoT adoption” heading 

• Autofit to Window 

• Separate text at Tabs 

 

Task 18 – Format the table 

Change the Table Styles  

  Assign to converted table from previous task 

 Table Style  : List Table 7 Colourful – Accent 4 
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OBJECTIVE 4 

“Apply References” 

 

Tujuan Praktikum 

Praktikum ini bertujuan untuk memberikan pengetahuan dasar kepada praktikan mengenai 

fungsi menu References pada Ms. Word 2013 yang meliputi Footnote, Endnote, dan Caption. 

Dokumen-dokumen latihan dapat diakses pada halaman E-Learning yang dibagikan oleh dosen 

pengampu perkuliahan.  

 

Task 1 – Inserting Footnote  

Insert a footnote 

 Place the reference mark directly after the word “Hanau” in the middle of the 1st  

       paragraph (“Word_4-1.docx”) 

 Footnote text: “Near Frankfurt, in the German state of Hesse” 

 

Task 2 – Modifying footnote   

Modify the footnote 

 Apply to the footnote referred to Hanau only 

 Location  : Below text 

 Number format : lowercase roman numerals 

 Numbering  : Restart each section 

 

Task 3 – Inserting endnote 

Insert an endnote 

 Apply to the word “Jacob” at the beginning of the 1st paragraph 

 Endnote text  : “Jacob Grimm lived from 1785-1863” 
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Task 4 – Modifying endnote 

Modify the endnote 

 Apply to the whole document 

 Number format : symbols 

 Start at   : ‡ 

 

Task 5 – Converting footnote to endnote 

Convert the footnote to endnote 

 Apply to the whole document 

 Convert all footnotes to endnotes 

 

Task 6 – Create caption 

Insert a figure caption  

  Below the figure in the 1st page of “Word_4-2.docx” document 

 Label  : Figure 

 Position : Below selected item 

 Caption : “Man sleeping under apple tree” 

 

Task 7 – Inserting the table of figures 

Insert the table of figures 

 To the last page of the document (“Word_4-2.docx”) 

 Format : Distinctive 

 

Task 8 – Create caption 

Create a table caption 

 In the center above the table in “Word_3-2a.docx” document 

 Label  : Table 

 Position : Above selected item 

 Caption : “List of contacts for the upcoming road trip” 
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SIMULASI 3 

OBJECTIVE 1 – OBJECTIVE 5 

 

Petunjuk: 

1. Kerjakan 25 soal di bawah ini dalam waktu 60 menit 

2. Anggap simulasi ini adalah ujian sertifikasi sungguhan, sehingga Anda harus sungguh-

sungguh dalam mengerjakannya. 

3. Ingat, bacalah soal baris per baris mulai dari baris pertama. 

4. Usahakan untuk tidak membuka catatan. 

5. Dokumen-dokumen latihan dapat diunduh dari halaman E-Learning UTY 

 

Soal: 

Task 1 – Margin  

Modify the margin 

 Apply to the whole document 

 Top  : 2,5 cm (0,98”) 

 Bottom : 2,5 cm (0,98”) 

 Right  : 3,2 cm (1,26”) 

 Left  : 3,2 cm (1,26”) 

 

Task 2 – Page Border  

Create page border 

 Apply to the whole document 

 Setting : Box 

 Color  : Blue, Accent 1 

 Width : 1½ pt 
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Task 3 – Modify Style 

Modify Heading 1 style 

 Document styles  

 Font  : Times New Roman (Bold, 14 pt) 

 Spacing after : 6 pt 

 

Task 4 – Apply Style 

Apply style to text 

 The four headings below “Internet of things and smart cities” title 

 Heading 1: 

• “Introduction” 

• “Conclusions” 

 Heading 2: 

• “Different scenarios of IoT adoption” 

• “IPV6 adoption” 

 

Task 5 – Insert Section Break 

Insert section break 

 Before “Different scenarios of IoT adpotion” heading 

 Section break Next Page  

 

Task 6 – Insert Page Numbers  

Insert page numbers 

 The bottom left of all pages 

 Bottom of page Accent Bar 1 
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Task 7 – Insert Hyperlink 

Insert a hyperlink 

 Use the text “The Internet of things” at the beginning of the first paragraph below the  

 “Introduction” heading 

 Link to “Different scenarios of IoT adoption” heading 

 

Task 8 – Page Alignment  

Align the page vertically 

 Apply to the first page only 

 Vertical alignment : Center 

 

Task 9 – Insert Columns   

Insert column 

 To the text “Security … Safety” below “Different scenarios of IoT adoption” heading 

 Number of columns : 2 

 

Task 10 – Insert Multilevel List  

Create a List 

 Text “Security … Safety” located below “Different scenarios of IoT adoption” heading 

 Type  : Multilevel List 

 Number style : 1., 1.1, 1.1.1, etc. 

 Level 1 “Security”, “Connected Office”, “Public services in smart cities”, 

“Stores” 

 Level 1 text format Bold 
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Task 11 – Insert Bulleted List 

Insert a bulleted list 

 Apply to the text “The things connected … Data processing systems” below “Different 

scenarios  

 of IoT adoption” heading 

 Define New Bullet picture “chrome.png” 

 Indent bullet position : 0,3 cm (0,12”) 

 Text indent position : 1 cm (0,39”) 

 

Task 12 – Insert Bookmark 

Insert a bookmark 

 Assign to “Conclusions” heading 

 Bookmark name : “conclusion” 

 

Task 13 – Paragraph Spacing 

Modify the paragraph spacing 

 Assign to “Internet of things and smart cities” title 

 Spacing after : 42 pt 

 

Task 14 – Footnote 

Insert footnote 

  Place the note reference mark directly after the word “4G-LTE” in the second paragraph 

below  

 “Different scenarios of IoT adoption” heading 

 Footnote text : “LTE stands for Long Term Evolution” 
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Task 15 – Text to Table 

Convert text to table 

 Text “Rank; … 51%, 29%” in the first page 

• Autofit to window 

• Separate text at semicolon 

 

Task 16 – Modify Table 

Modify the table 

  The converted table 

 Table header font size  : 9 pt 

 Table style  : List table 2, Accent 5 

 Align center the entire row of “Rank” column 

 Delete the blank rows in the table 

 The table should be 11 rows x 7 columns  

 

Task 17 – Table to Text 

Convert the table to text 

  The table below “Different scenarios of IoT adoption” heading 

 Separate text with Tabs 

 

Task 18 – Picture Position 

Modify the picture position and text wrapping 

  Picture in the 4th page 

 Wrap text : Through 

 Horizontal alignment Right relative to Margin 

 Vertical absolute position 1 cm (0,39”) below Margin 
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Task 19 – Picture Caption 

Insert a picture caption 

  Below the picture in page 4 

 Label  : Figure 

 Position : Below selected item 

 Caption : “-Percentage of users that access Google over IPV6” 

 

Task 20 – Modify SmartArt 

Modify the SmartArt 

  Below “IPV6 adoption” heading 

 Layout : Lined List 

 Height  : 7 cm (2,76”) 

 Width : 12 cm (4,72”) 

 

Task 21 – Text Box 

Insert and modify a Text Box 

  Below the last paragraph in page 3 

 Text Box : Austin Quote 

 Cut the last paragraph of page 3, and paste inside the text box 

 Horizontal alignment Centered relative to Margin 

 Vertical absolute position 3 cm (1,18”) below Paragraph  

 Keep the Austin Quote format 

 

Task 22 – Document Properties 

Add a document property 

  “Simulasi 3 – File.docx” 

 Title  : “internet of things” 

 Subject : “internet” 
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Task 23 – Insert Text from File 

Insert text from a file 

  Place the text before “IPV6 adoption” heading 

 File source : “Simulasi 3 – File 2.docx” 

 

Task 24 – Save Options 

Modify the Save options 

  “Simulasi 3 – File.docx” 

 Save Auto Recover information every 7 minutes 

 Embed fonts in the file 

 

Task 25 – Navigation Pane 

Open the Navigation Pane 

 “Simulasi 3 – File.docx” 

 Open the Navigation Pane 

• Leave open when submitting exam 
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OBJECTIVE 5 

“Insert and Format Objects” 

 

Tujuan Praktikum 

Praktikum ini bertujuan untuk memberikan pengetahuan lanjutan kepada praktikan mengenai 

teknik pengolahan gambar/ objek dan diagram/ grafik pada Ms. Word 2013. Pembahasan fokus 

pada fungsi-fungsi pada menu Insert. Dokumen-dokumen Latihan dapat diakses pada halaman 

E-Learning yang dibagikan oleh dosen pengampu perkuliahan.  

 

Task 1 – Inserting Text Box 

Insert a textbox 

 Below the last paragraph in the last page  

 Textbox : Banded Quote 

 Cut the last paragraph of the document, and paste inside the textbox 

 Position : In Line with Text 

 

Task 2 – Inserting a shape 

Insert a shape 

 To the right side of the first paragraph 

 Basic shapes  : Sun 

 Wrap text  : Through 

 Shape Effects : Shadow (Offset: Center) 
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Task 3 – Insert and Modify Smart Art  

Insert and modify a Smart Art 

 Below the first paragraph 

 SmartArt Graphic : Continuous Block Process 

 Use block process as content 

 Shapes  : 5 

 Height  : 7,5 cm 

 Width  : 16,5 cm 

 

Task 4 –Modify Smart Art  

Modify a Smart Art 

 SmartArt created in the previous task 

 Fill each block process : “P1”, “P2”, “P3”, “P4”, and “P5” 

 Move the “P2” block to the right side of “P4” block 

 

Task 5 –Modify Smart Art  

Modify a Smart Art 

 SmartArt created in the previous task 

 Text wrapping  : Through 

 Horizontal Alignment Right Relative to Margin 

 Vertical Absolute Position 1 cm below Margin 

 

Task 6 – Inserting a picture 

Insert a picture 

 Between the 1st and the 2nd paragraph (“Word_5-3a.docx”) 

 Picture file : “Word_5-3b.jpg” 

 Height   : 12 cm 
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Task 7 – Modifying the text wrapping and position of the picture  

Modify the text wrapping and position of the picture 

 Apply to the picture of little princess with blue gown 

 Wrap text : Through 

 Horizontal Alignment Left Relative to Margin 

 Vertical Alignment Centered Relative to Margin 

 

Task 8 – Inserting text from certain file 

Insert text from a file 

 Place text directly under the last paragraph 

 File source : “Word_5-2.docx” 
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SIMULASI 4 

OBJECTIVE 1 – OBJECTIVE 5 

 

Petunjuk: 

1. Kerjakan 25 soal di bawah ini dalam waktu 50 menit 

2. Anggap simulasi ini adalah ujian sertifikasi sungguhan, sehingga Anda harus sungguh-

sungguh dalam mengerjakannya. 

3. Ingat, bacalah soal baris per baris mulai dari baris pertama. 

4. Usahakan untuk tidak membuka catatan. 

5. Dokumen-dokumen latihan dapat diakses pada halaman E-Learning UTY. 

 

Soal: 

Task 1 – Margin  

Modify the margin 

 Apply to the whole document 

 Top  : 2,5 cm (0,98”) 

 Bottom : 2,5 cm (0,98”) 

 Right  : 3,2 cm (1,26”) 

 Left  : 3,2 cm (1,26”) 

 

Task 2 – Page Border  

Create page border 

 Apply to the whole document 

 Setting : Box 

 Color  : Orang, Accent 2 
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Task 3 – Modify Style 

Modify Heading 1 style 

 Document styles  

 Font  : Times New Roman (Italic, 16 pt) 

 Spacing after : 6 pt 

 

Task 4 – Apply Style 

Apply style to text 

 The four headings below “Internet of things and smart cities” title 

 Heading 1: 

• “Introduction” 

• “Conclusions” 

 Heading 2: 

• “Different scenarios of IoT adoption” 

• “IPV6 adoption” 

 

Task 5 – Insert Section Break 

Insert section break 

 Before “Different scenarios of IoT adoption” heading 

 Section break Next Page  

 

Task 6 – Insert Page Numbers  

Insert page numbers 

 The bottom right of all pages 

 Bottom of page Accent Bar 4 
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Task 7 – Insert Hyperlink 

Insert a hyperlink 

 Use the text “Internet of things” at the beginning of the second paragraph below the  

 “Introduction” heading 

 Link to “Different scenarios of IoT adoption” heading 

 

Task 8 – Page Alignment  

Align the page vertically 

 Apply to the first page only 

 Vertical alignment : Center 

 

Task 9 – Insert Columns   

Insert column 

 To the text “Security … Safety” below “Different scenarios of IoT adoption” heading 

 Number of columns : 2 

 

Task 10 – Insert Multilevel List  

Create a List 

 Text “Security … Safety” located below “Different scenarios of IoT adoption” heading 

 Type  : Multilevel List 

 list style : 1, 1.1, 1.1.1, … etc 

 Level 1 “Security”, “Connected Office”, “Public services in smart cities”, 

“Stores” 

 Level 1 text format Bold 
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Task 11 – Insert Bulleted List 

Insert a bulleted list 

 Apply to the text “The things connected … Data processing systems” below “Different  

       scenarios of IoT adoption” heading 

 Define New Bullet picture “chrome.png” 

 Indent bullet position : 0,3 cm (0,12”) 

 Text indent position : 1 cm (0,39”) 

 

Task 12 – Insert Bookmark 

Insert a bookmark 

 Assign to “Conclusions” heading 

 Bookmark name : “conclusion” 

 

Task 13 – Drop Cap 

Insert a drop cap 

 “The Internet of things” at the beginning of the first paragraph of “Introduction” heading 

 Type : Dropped 

 

Task 14 – Footnote 

Insert footnote 

  Place the note reference mark directly after the word “WiFi” in the second paragraph  

        below “Different scenarios of IoT adoption” heading 

 Footnote text : “WiFi stands for Wireless Fidelity” 

 

Task 15 – Text to Table 

Convert text to table 

 Text “Rank; … 51%; 29%” in the first page 

• Autofit to window 

• Separate text at semicolons 

 



40 

 

Task 16 – Modify Table 

Modify the table 

  The converted table 

 Table header font size  : 9 pt 

 Table style  : List table 2, Accent 5 

 Align center the entire row of “Rank” column 

 Delete the blank rows in the table 

 The table should be 11 rows x 7 columns 

 

Task 17 – Table to Text 

Convert the table to text 

  The table below “Different scenarios of IoT adoption” heading 

 Separate text with Tabs 

 

Task 18 – Picture Position 

Modify the picture position and text wrapping 

  Picture in the 3rd page 

 Wrap text : Through 

 Horizontal alignment Left relative to Margin 

 Vertical absolute position 1 cm (0,39”) below Margin 

Task 19 – Table Caption 

Insert a table caption 

  Above the picture in page 1 

 Label  : Table 

 Position : Above selected item 

 Caption : “-Top 10 countries with the fastest internet connection speed” 
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Task 20 – Modify SmartArt 

Insert and Modify the SmartArt 

  Above the last paragraph of “IPV6 adoption” heading 

 SmartArt Graphic : Horizontal Bulleted List 

 Shapes  : 2 (remove 1 shape) 

 Content for 1st shape 

• Level 1: “IPv4” 

• Level 2: “Limited”, “Decimal Encoding”, “32 bit”, “Manual” 

 Content for 2nd shape 

• Level 1: “IPv6” 

• Level 2: “Unlimited”, “Hexadecimal Encoding”, “128 bit”, 

“Automatic” 

 Height  : 8 cm (3,15”) 

 Width  : 12 cm (4,72”) 

 

Task 21 – Text Box 

Insert and modify a Text Box 

  Below the last paragraph in page 4 

 Text Box : Banded Quote 

 Cut the last paragraph of page 4, and paste inside the text box 

 Horizontal alignment Centered relative to Margin 

 Vertical absolute position 3 cm (1,18”) below Paragraph  

 Keep the Austin Quote format 

 

Task 22 – Document Properties 

Add a document property 

  “Simulasi 4 – File.docx” 

 Title  : “internet of things” 

 Subject : “internet” 
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Task 23 – Insert Text from File 

Insert text from a file 

  Place the text before “IPV6 adoption” heading 

 File source : “Simulasi 3 – File 2.docx” 

 

Task 24 – Save Options 

Modify the Save options 

  “Simulasi 3 – File.docx” 

 Save Auto Recover information every 7 minutes 

 Embed fonts in the file 

 

Task 25 – Navigation Pane 

Open the Navigation Pane 

 “Simulasi 3 – File.docx” 

 Open the Navigation Pane 

• Leave open when submitting exam 

 

 


